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Getting Started
As we begin this book on the AutoCAD® program, I’m reminded of a quote 
by Chinese philosopher Lao-Tzu: “A journey of a thousand miles begins with 
a single step.” In much the same way, learning AutoCAD is something any-
one can do by taking it one step at a time. And I promise that AutoCAD is 
much easier than walking a thousand miles!

By buying this book, you have already taken the first step in this journey. 
When you finish, you will have a solid understanding of AutoCAD.

In this chapter, you’ll learn to do the following:

▶▶ Sign in to Autodesk® 360 on the Start tab

▶▶ Explore the AutoCAD 2018 for Windows user interface

▶▶ Set drawing units

Sign In to Autodesk 360 on the Start Tab
Autodesk 360 is a cloud-based service that is integrated with AutoCAD. You 
have the option of automatically storing up to 5 GB of your drawing files in 
the cloud for free. The files you store in the cloud can be edited online and 
shared with others with your permission.

The Start tab appears when you launch the program. You can create new 
drawings, access existing drawings, connect to AutoCAD 360, receive noti-
fications, and access a live chat with sales on the Try page that appears on 
trial versions, all on the Start tab.

Exercise 1.1: Configure Autodesk 360
To begin, launch AutoCAD 2018.

	 1.	 Click the Sign In button in the Connect section of the Start tab 
(see Figure 1.1).
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F ig  u r e   1 . 1   Clicking Sign In on the AutoCAD Start tab

	 2.	 Sign in with an Autodesk ID or email address and password. If you 
don’t already have an Autodesk ID, click the Create Account link and 
create one online (see Figure 1.2).

F ig  u r e   1 . 2   Signing in or creating an Autodesk ID

	 3.	 After you sign in using an Autodesk ID, the Default Autodesk 360 
Settings dialog box appears. Select Sync My Settings (see Figure 1.3).

	 4.	 Click the large Start Drawing button in the Get Started section of the 
Start tab.

Take advantage of free 
cloud storage while you 
use this book. Storing 
your files offsite in the 
cloud is an effective 
backup strategy.

▶
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F ig  u r e   1 . 3   Setting Autodesk 360 options

This loads the full AutoCAD user interface, which you will learn about in the 
next exercise.

Using Autodesk 360
Whenever you save your work in AutoCAD, a copy of your file will be uploaded to 
Autodesk 360 in the background. You can access this content at http://a360 
.autodesk.com (as shown here) or within AutoCAD from the A360 tab on 
the ribbon. You will learn about the ribbon in Exercise 1.3.
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Explore the AutoCAD 2018 for Windows 
User Interface
Autodesk has recently released new versions of AutoCAD, including the 
AutoCAD® 2018 and AutoCAD LT® 2018 software. The two Windows versions 
look nearly identical and function in almost the same way. The main difference 
between them is that AutoCAD LT doesn’t support automation and some of the 
advanced 3D functions. Although this book was written using AutoCAD 2018 
running on Windows 7, you can use it to learn any of the current versions of 
AutoCAD.

Exercise 1.2: Explore the Graphical User 
Interface
Before you can use AutoCAD, you’ll need to familiarize yourself thoroughly 
with its graphical user interface (GUI). Figure 1.4 shows the AutoCAD 2018 (for 
Windows) user interface.

▶

AutoCAD for Mac has a 
user interface that is 
customized to the Mac 
experience. Although 
the Mac user interface 
is not covered in this 
book, its commands and 
capabilities are similar 
to those in AutoCAD for 
Windows (albeit with a 
slightly reduced set of 
features).

F ig  u r e   1 . 4   AutoCAD 2018 user interface
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Let’s now step through the basic user interface for AutoCAD.

	 1.	 Click the Application menu to open it. Type polygon and observe that 
the text appears in the search box at the top of the Application menu. 

Certification
Objective
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The search results (see Figure 1.5) list many related AutoCAD com-
mands. Search is useful when you’re not sure how to access a com-
mand in the interface or what its exact name is.

F ig  u r e   1 . 5   Searching for commands in the Application menu

	 2.	 Click the red X at the extreme right edge of the search box to 
make the initial Application menu interface reappear. Here you 
can create new or open existing drawings, export or print draw-
ings, and more. Hover the cursor over Open and then click 
Drawing (Figure 1.6).

	 3.	 Select the following sample file; then click Open in the Select File 
dialog box:

C:\Program Files\Autodesk\AutoCAD 2018\Sample\
Sheet Sets\Manufacturing\VW252-02-0142.dwg
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The Sheet Set Manager appears when the sample file is opened 
(see Figure 1.7). This palette automatically appears when you open 
any drawing that’s part of a sheet set. AutoCAD has many palettes to 
organize tools and reusable drawing content.

F ig  u r e   1 . 7   Opening a sample drawing reveals the Sheet Set Manager.
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F ig  u r e   1 . 6   Opening a drawing from the Application menu

▶

Sheet sets are an 
optional feature in 
AutoCAD.
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	 4.	 Click the Sheet Views tab along the edge of the Sheet Set Manager 
and observe that tabs provide a means of accessing additional inter-
face content. In its present state, the Sheet Set Manager is a floating 
palette. Drag its palette bar and relocate it onscreen.

	 5.	 Click the Auto-hide toggle and watch the palette collapse to its verti-
cal palette bar; this saves space onscreen. Hover the cursor over the 
palette bar and watch the whole palette reappear so that you can 
access its content. Now toggle Auto-hide off.

	 6.	 Click the Palette properties menu and select Anchor Left. The Sheet 
Set Manager palette is docked along the left edge of the user inter-
face. You can use many options to organize the user interface to 
match the way you work.

	 7.	 Select Sheet Views on the tabbed interface. Double-click Detail-B 
under 04 – Brush Roller Sub Assy in the Manufacturing sheet set (see 
Figure 1.8). A new drawing appears in the drawing window.

Certification
Objective

◀

Drag floating palettes 
to a secondary moni-
tor if you have one to 
maximize the drawing 
area on your primary 
monitor.

F ig  u r e   1 . 8   Selecting a drawing
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	 8.	 Click the Open button in the Quick Access toolbar. Select any draw-
ing in the Manufacturing folder and click Open. Once you open a 
drawing, pressing Ctrl+Home or using the GOTOSTART command 
brings you back to the Start tab.

	 9.	 Move the cursor over the drawing that you opened in the previous 
step’s tab and observe two icons. Click Model to open the drawing’s 
model space (see Figure 1.9).

▶

The Quick Access 
toolbar is a convenient 
way to open drawings, 
especially when you’re 
not using the Sheet Set 
Manager.

F ig  u r e   1 . 9   Accessing open drawings and their spaces

	 10.	 Move the cursor over the current drawing tab and click Brush Roller 
Sub Assy to reopen the layout.

	 11.	 Click the Save button on the Quick Access toolbar. The drawing is 
saved locally on your hard drive, and a backup copy is also automati-
cally uploaded to your Autodesk 360 account. Click the file tab of 
Drawing 1 and close all the sample files by typing CLOSEALLOTHER 
and pressing Enter. In addition, close the Sheet Set Manager.  

AutoCAD Drawing Spaces
AutoCAD has two types of drawing spaces: paper and model. Paper space is a 
two-dimensional area analogous to, and having the dimensions of, a sheet of 
paper. Various sizes of “paper” can be created in individual layouts (see Chapter 13, 
“Working with Layouts and Annotative Objects”). Model space, on the other hand, 
is a single three-dimensional volume where everything is drawn in actual size. 

The DWG format has 
been updated in 
AutoCAD 2018, improv-
ing opening and saving 
performance.

▶
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Model space is typically scaled down in viewports and displayed in the paper 
space of layouts. Most of the drawing you will do in AutoCAD will be in model 
space. A drawing can have only one model space, whereas any number of layouts 
displaying model space through viewports can be saved in the same file.

Exercise 1.3: Control the AutoCAD Ribbon
AutoCAD has so many palettes and ribbon controls that finding the right tool 
for the job can seem like a job in itself. The ribbon is therefore an important fea-
ture that was introduced to AutoCAD 2010. Autodesk adopted Microsoft’s ribbon 
standard to organize the ever-increasing number of toolbars in a single palette, 
making tools much easier to find. Now let’s explore the various ribbon modes 
and identify the user interface elements of each mode (see Figure 1.10).

Certification
Objective

F ig  u r e   1 . 1 0   The full ribbon interface
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	 1.	 Open the Customize Quick Access Toolbar menu and choose 
Workspace. Choose the 3D Basics workspace from the drop-down 
menu in the Quick Access toolbar. Close the Tool palette if it is open.

Workspaces
Workspaces (not to be confused with drawing spaces) are stored sets of user inter-
face controls, which include floating palettes and the configuration of the ribbon. 
People use workspaces to configure the interface quickly for the task at hand.

	 2.	 Click the Minimize Ribbon button and observe that the full ribbon 
changes to display tabs and panel buttons (see Figure 1.11). Hover the 
cursor over the panel buttons. The buttons expand to reveal all the 
tools shown on the full ribbon.
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	 3.	 Click the Minimize Ribbon button again. The panel buttons change 
into panel titles. Hover the cursor again over the titles to reveal each 
panel’s tools.

	 4.	 Click the Minimize Ribbon button again. Hovering the cursor over 
the tabs doesn’t have any effect. Click the Home tab to reveal the 
full panel temporarily. It disappears after you move the cursor 
away.

	 5.	 Verify that Cycle Through All is selected in the Minimize Ribbon but-
ton’s menu and then click the Minimize Ribbon button one last time. 
The full ribbon interface is restored.

	 6.	 Click the Edit button at the bottom of the Edit panel to reveal addi-
tional tools. Hover the mouse over one of the tools to display a tooltip 
that identifies the tool and describes its function. Holding the cursor 
a while longer reveals an image that illustrates what the tool does 
(see Figure 1.12).

	 7.	 Observe that the bottom of the tooltip shown in Figure 1.12 reveals 
the command name (SOLIDEDIT in this case). The ribbon, menus, 
toolbars, and palettes are all graphical alternatives to typing 
commands.

	 8.	 Press and release the Alt key. Keytips appear on the ribbon (see 
Figure 1.13). Pressing any of the letter combinations activates that 
part of the GUI. Type IN and observe that the Insert tab is selected 
without moving the cursor.

Certification
Objective

▶

I recommend using the 
full ribbon interface 
until you learn the 
location of all the tools. 
Use one of the mini-
mized modes to save 
space onscreen.

F ig  u r e   1 . 1 1   Ribbon modes
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▶

AutoCAD is based on 
commands. If you know 
the name of a command, 
you can type it instead of 
finding it in the GUI.
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F ig  u r e   1 . 1 2   Tooltip and illustration

F ig  u r e   1 . 1 3   Keytips allow you to press keys to manipulate the ribbon with 
the keyboard.

	 9.	 Press the F2 key to open the AutoCAD Text window. The bottom line, 
Command:, is called the command line. It is the active line where com-
mands appear, regardless of whether they are typed or triggered from 
the GUI. The complete history of commands scrolls upward as new 
commands are entered. Close the AutoCAD Text window. Two lines of 
this command history appear at the bottom of the user interface, just 
above the command line that reads Type a command by default.

If you undock the 
command line, it can 
be configured to be 
partially transparent 
and to show a number 
of lines of prompt 
history.

◀
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	 10.	 The application status bar contains a coordinate readout on the left 
and a number of status toggle buttons, as shown in Figure 1.14. The 
icons that have arrows adjacent to them open menus. Toggle off all 
the status bar toggles so that no icons are highlighted in blue. Open 
the customization menu by clicking the rightmost icon on the status 
bar and deselect Clean Screen, Coordinates, Isometric Drafting, and 
Annotation Monitor from the context menu that appears. You can 
control which buttons appear on the status bar using this menu.

F ig  u r e   1 . 1 4   Status bar

Coordinate readout

Customization menuStatus toggles

	 11.	 Type POL and observe how the AutoComplete feature highlights 
commands in alphabetical order as you type (see Figure 1.15). Use the 
arrow keys to move up or down through the list; press Enter when 
you find the command for which you are looking, or click its name in 
the list instead of typing the entire word.

F ig  u r e   1 . 1 5   Command line’s AutoComplete feature

	 12.	 Take a look at the InfoCenter at the top right of the screen (see 
Figure 1.16). Click in the search box and type solid.

F ig  u r e   1 . 1 6   InfoCenter
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▶

Some commands and 
system variables can be 
quite lengthy, so using 
AutoComplete saves 
time typing.
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	 13.	 Click the binoculars icon on the right of the search field, and 
the AutoCAD Help dialog box appears. Multiple online books are 
searched, and relevant results appear in the left panel. The descrip-
tion of the SOLID command appears in the right panel.

	 14.	 Click the Help button on the right edge of the InfoCenter. The Help 
Table Of Contents page opens. All AutoCAD documentation is acces-
sible through this interface.

	 15.	 Open the Quick Access toolbar’s workspace drop-down and 
select Drafting & Annotation to restore the ribbon to its original 
configuration.

Set Drawing Units
Before you start drawing, it’s important to decide what one drawing unit rep-
resents in the real world. Architects in the United States typically equate one 
drawing unit with 1 inch in AutoCAD. You need to choose a unit type that 
matches your country’s industry standard.

Architectural    Most American architects will choose this type, which dis-
plays units in feet and inches. For example, 12', 6 ½" is typed as 12'6-1/2. The 
hyphen is used to separate inches from fractions of an inch rather than feet 
from inches.

Decimal    Metric users should select this type. One decimal unit can be equal 
to 1 millimeter, 1 centimeter, or any metric unit that you decide.

Engineering    Like the Architectural type, engineering units feature feet and 
inches, but the inches are represented in decimal form—for example, 126.500 
feet.

Fractional    American woodworkers often prefer to set AutoCAD drawings in 
fractional units of inches because that is how their work is normally reckoned. 
For example, 12', 6 ½" reads 150- ½" in fractional units.

Scientific    In scientific units, 12.000E+06 is broken down into two parts: 
12.000 indicates 12 accurate to a precision of three decimal places, and E+06 
indicates the exponential function raised to the sixth power, or 10 × 10 × 10 × 
10 × 10 × 10, bringing the total in this example up to 12 million.

◀

The AutoCAD Exchange 
website contains the 
Apps store, where 
you can access free 
and paid apps that 
add functionality to 
AutoCAD.
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Exercise 1.4: Set the AutoCAD Drawing Units
Let’s set the AutoCAD drawing units.

	 1.	 Click the New button on the Quick Access toolbar. Click the arrow 
button next to the Open button in the Select Template dialog box and 
choose Open With No Template – Imperial (see Figure 1.17).

Certification
Objective

F ig  u r e   1 . 1 7   Opening a drawing with no template

	 2.	 Type UN and press Enter to bring up the Drawing Units dialog box (see 
Figure 1.18). UN is the command alias (abbreviation) of the UNITS 
command. Most commands have aliases that minimize typing.

F ig  u r e   1 . 1 8   Setting drawing units

You can press Enter or 
the spacebar to enter 
commands (command 
names never have 
spaces). Commands 
and their options can 
be typed in uppercase 
or lowercase.

▶
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	 3.	 Select Architectural from the Type drop-down menu. I’m using 
Architectural in this book, but you should select the unit type that 
fits your industry when working professionally. Metric users should 
select Decimal length units.

	 4.	 Click the Length Precision drop-down menu and select 1/8″  
(or 0.0 for metric). Set Angle Type to Decimal Degrees and Angle 
Precision to 0.0.

	 5.	 Click the Insertion Scale drop-down menu and select Inches  
(or Centimeters for metric). Click OK to close the Drawing Units  
dialog box.  

AutoCAD 2018 has 
US Survey Feet as an 
option for insertion 
scale units.

◀

Now You Know

In this chapter, you learned how to sign in to Autodesk 360, open and save sample drawings, 
identify user interface elements, access model space and paper space, change workspaces, 
control the appearance of the ribbon, type commands using AutoComplete, identify commands 
in the graphical user interface, and set the drawing units.




